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Introduction

UMB’s HSA Contributions Manager automates the process of making contributions to employee 
HSA accounts. Instead of faxing cumbersome paper forms, or the time-consuming process of 
mailing your forms along with a check, you can use the HSA Contributions Manager to quickly 
and easily complete online screens that have already been populated with employee names and the 
last four digits of the Social Security Numbers. The system continually tracks running totals as you 
enter employee contribution and employer contribution amounts for each employee. The system also 
enables you to pre-populate the system with amounts from a previously submitted batch, or even 
import payroll contribution data from an Excel spreadsheet.

After you have entered the appropriate contribution amounts, you specify an account from which 
to debit the funds. Once you have selected the account and submitted the batch, the funds are 
electronically transferred from the account you specified to the employees’ HSA accounts. 

You can use the HSA Contributions Manager to make employee HSA account contributions as 
often as your company processes require. The system also enables you to make contributions for the 
previous tax year, through the customary IRS tax filing deadline of April 15.

This guide provides illustrated, step-by-step instructions on accessing the 
HSA Contributions Manager and using the system to contribute funds to HSA accounts. The guide 
also includes instructions on viewing detailed reports on the HSA accounts in your organization.

Disclaimer
This guide does not purport to be, and should not be considered to be advice on, or an explanation of, 
all issues and other considerations relevant to an employer’s administration of employee HSAs. This 
guide reflects the UMB HSA Employer Portal at the time the guide was produced and information 
in this guide is subject to change without notice. UMB makes no commitment to update this guide 
and assumes no responsibilities for any inaccuracies that may be contained in this guide. This guide 
is not intended to make any representation regarding the performance of the UMB HSA Employer 
Portal and UMB is not responsible for a failure of the UMB HSA Employer Portal to perform as 
described herein.
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What’s New in Version 6.11

The HSA Contributions Manager User’s Guide has been updated since version 6.0 was released in 
July 2021. The changes are detailed below.

Updated Login Interface
The login and security setup screens have been updated. For more information, see “Setting Up Your 
Web Exchange Security Profile” on page 3.
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Accessing the HSA Contributions Manager

You access the HSA Contributions Manager via Web Exchange hsa.umb.com. 

Browser Requirements
Our Web site was designed for best results using the following specifications:

•	 Internet browser - Firefox 10 or later, Internet Explorer 8 or later, Safari 5 for Mac OS x only.

•	 Monitor colors - minimum 256 colors

•	 Monitor resolution - 1024 x 768 pixels

•	 128-bit encryption is required to use our online tools such as online banking.

UMB Customer Technical Support can be reached at (816) 860-3999.

Setting Up Your Web Exchange Security Profile
When you log on to Web Exchange the HSA Contributions Manager you must enter a user ID and 
password. This prevents others from accessing your information. The highest level of encryption 
available scrambles the information being sent from your computer. This information can only be 
decoded by the bank’s servers.

In addition to your username and password, you must create a unique security profile. This profile 
assists UMB in recognizing you and your computer as well as verify for you that you are on the 
authentic UMB Web site.

If your group has only Health Savings Accounts, sign in at this address:

https://hsa.umb.com/employers/home

If your group has Benefit Spending accounts or Health Savings accounts and Benefit Spending 
Accounts, sign in at this address: 

https://umb.com/employer-benefit-accounts

Web Address: https://www.umb.com/Commercial/index.html

1.	 Type the user name supplied to you by UMB in the User ID field and click the Next button.

https://hsa.umb.com/employers/home
https://umb.com/employer-benefit-accounts
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2.	 Type in the User ID supplied to you by UMB and click Log In.

3.	 Enter the temporary password and click Log In.



Accessing the HSA Contributions Manager	 5

HSA Contributions Manager User’s Guide

4.	 This screen explains the setup of your Security Profile. Click Next.

5.	 Select five pre-written security questions and type in your answers. Click Next.
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6.	 Create your own identity question and answer. The question/answer should be information only 
known by you. It may used to verify your identity if you call UMB for technical support. Click 
Next.

7.	 The next screen is a confirmation of all your security questions. Click Next.
Your temporary password now expires, and you must change it.

8.	 Enter temporary password in Old Password box. Enter a new password twice using the password 
policy noted.  
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9.	 Click Submit and the main dashboard will display.

NOTE:	 You can change your password and security questions at any time by clicking My 
Security Profile. 

NOTE:	 To return to the dashboard at any time, click the UMB logo in the upper left 
corner of the screen. 

Viewing Demo Videos
To view video overviews of HSA Employer Portal functionality, click Documents and select 
Contributions Demo.
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Entering and Funding Contributions

The HSA Contributions Manager provides you three options for making 
contributions to employee HSAs. You can use any option at any time.

•	 List of Employees
With this option, the system lists your employees with HSAs, and you manually 
enter employer and/or employee contributions.

See “Manually Entering Contribution Amounts” on page 8.

•	 Previous Batch
This option enables you to use a previously submitted contribution batch as a template, adding 
employees or modifying amounts as necessary.
See “Populating from a Previous Batch” on page 12.

•	 Upload Excel
This option enables you to import payroll contribution data from an Excel spreadsheet.
See “Importing Contributions from an Excel File” on page 17.

NOTE:	 Your session will time out after 15 minutes of inactivity, logging you off of the 
system. If you are entering contribution amounts when the session times out, 
you will lose that data. Five minutes before the session times out, a warning 
(illustrated below) pops up.  

 
Moving your mouse or typing within the interface will “reset the clock” and keep 
you logged in.

Manually Entering Contribution Amounts
To enter and submit online employee and/or employer contributions, follow the steps below.

1.	 Click the Contributions menu and select List of Employees. This list displays all employees with 
HSAs, with fields for employee and/or employer contribution amounts.
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2.	 Search for employees by entering search criteria in the Search box and pressing <Enter>. You can 
search by first name, last name or Tax ID.

3.	 Specify the number of employees to list on each page of results by selecting the appropriate 
number from the dropdown menu to the right of the search box.

4.	 Select the check box for the effective year of the contributions, either the current year or the 
previous year. (If it is too late in the year to make contributions for the prior year, the prior year is 
unavailable.)

NOTE:	 Switching years automatically moves contributions to the year you select.

5.	 Enter the appropriate Employee and Employer contribution for each employee for the selected 
year. The total amount for the employee is displayed on the right in the Total YTD column so you 
can see how close the account is to excess. The total amount for the employer is displayed at the 
top of screen.

6.	 To view entries on previous or subsequent pages, click the page number links at the bottom of the 
page.

7.	 When you have entered the contribution amounts, click Submit. The Contributions Review page 
is displayed.
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The page displays information on your contribution batch, including the number of employees 
with contributions and the total amount of contributions.
If you need to make any changes to the contributions, click Go back and go back to step 2.

8.	 From the Funding Account list, select the account from which the contribution funds will be 
deducted.

NOTE:	 Contributions are memo posted to employee accounts immediately. Because of 
ACH processing times, it may take two to three business days for employers to 
see withdrawn funds.

9.	 If necessary, modify the default nickname for the batch in the Batch Nickname box. (The default 
nickname is a timestamp reflecting when the batch was created.) The nickname can help you 
identify the batch if you need to locate it later.

10.	Click Submit. The Contributions Receipt page displays the funding information, including the 
Debit Date, the Credit Date and the Available Date.
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•	 Debit Date 
Date that funds will be debited from the funding account that your company uses for 
employee HSA contribution.

•	 Credit Date
Date that funds will be credited into the employee’s HSA at UMB. The employee(s) will be 
able to see the contribution in the account but they will not be able to spend those funds until 
the funding ACH has cleared.

•	 Available Date 
Date that your employee(s) will be able to spend the dollars that were contributed to their 
HSAs. This date may be the same as Credit Date.

11.	 Print a copy of the page for your records.

12.	Click Close to return to the home page.
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Populating from a Previous Batch
To save you time and effort, the HSA Contributions Manager enables you to use previously 
submitted contribution batches as templates for current contributions. Selecting a previous batch pre-
populates the system with names, Social Security Numbers and contribution amounts that you can 
then modify as necessary.

You cannot contribute to accounts from previous batches that have since been closed. The accounts 
display, but with the contribution fields unavailable, as in the example below.

1.	 Click the Contributions menu and select Previous Batch. The Previous Batches page is displayed, 
enabling you to search for batches that fall within a specific date range. The page defaults to the 
last 60 days.

2.	 Enter a Start Date and End Date in the format MM/DD/YYYY.
-or-
Click the calendar icon  to select a date from a calendar.

3.	 Click Search.
The page refreshes, listing batch confirmation numbers, the day each batch was submitted, a 
nickname for each batch and details of each batch. (If no nickname was assigned to a batch, the 
batch defaults to a default nickname consisting of a timestamp reflecting the date and time it was 
created.)
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NOTE:	 You can click a column header to change the sort for that column. If you sort 
the batch list on the Nickname column, batches with no assigned nicknames 
always sort to the bottom of the list.

4.	 Search for batches by entering search criteria in the Search box and pressing <Enter>. You can 
search by batch name, batch ID or confirmation number.

5.	 Specify the number of batches to list on each page of results by selecting the appropriate number 
from the dropdown menu to the right of the search box.

6.	 To rename a batch (that is, to give it a new nickname), click the batch’s Edit link. An Edit Batch 
box opens. The default nickname is a timestamp reflecting when the batch was created.

Enter a new name in the Nick Name box and click Update. A confirmation message displays. 
Click OK to close the message.

7.	 Click a confirmation number to select a batch. The employees and contribution totals from the 
selected batch are displayed, as in the example below.
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You can click a column header to change the sort for that column.

NOTE:	 Multiple entries for a single employee are consolidated into a single entry.

8.	 Select the check box for the effective year of the contributions, either the current year or the 
previous year. (If it is too late in the year to make contributions for the prior year, the prior year is 
unavailable.)

NOTE:	 Switching years automatically moves contributions to the year you select.

9.	 If you need to add employees to the list, click the Add Employees link in the upper right corner 
of the page. The Add Employees page opens, listing your employees.
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Select the check boxes for the employees you want to add to the list, then click Add Employees. 
The Add Employees page closes and the employees are added to the top of the contribution list.

10.	Modify the appropriate Employee and Employer contribution amount for each employee for the 
selected year. 
The total amount is displayed at the top of screen.

NOTE:	 If any employees from the previous batch now have closed accounts, you will 
not be able to enter contributions for those employees.

11.	 To view entries on previous or subsequent pages, click the page number links at the bottom of the 
page.

12.	When you have finished entering or modifying the contribution amounts, click Submit. The 
Contributions Review page is displayed.
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The page displays information on your account, including the number of employees with 
contributions and the total amount of contributions.
If you need to make any changes to the contributions, click Go back and go back to step 8.

13.	From the Funding Account list, select the account from which the contribution funds will be 
deducted.

14.	If necessary, modify the optional nickname for the batch in the Batch Nickname box. (The default 
nickname is a timestamp reflecting when the batch was created.) The nickname can help you 
identify the batch if you need to locate it later.

15.	Click Submit. The Contribution Receipt page displays the funding information, including the 
Debit Date, the Credit Date and the Available Date.
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•	 Debit Date 
Date that funds will be debited from the funding account that your company uses for 
employee HSA contribution.

•	 Credit Date
Date that funds will be credited into the employee’s HSA at UMB. The employee(s) will be 
able to see the contribution in the account but they will not be able to spend those funds until 
the funding ACH has cleared.

•	 Available Date 
Date that your employee(s) will be able to spend the dollars that were contributed to their 
HSAs. This date may be the same as Credit Date.

16.	Print a copy of the page for your records.

17.	 Click Close to return to the home page.

Importing Contributions from an Excel File
The HSA Contributions Manager enables you to make contributions by importing payroll data from 
a Microsoft® Excel file. The Excel file should be formatted as follows:

•	 The file should be Excel 97 or higher.

•	 The file must contain four columns of data in the exact order below.

a.	 Social Security Number

b.	 Employee Name

c.	 Employee Contribution

d.	 Employer Contribution

•	 The first row of the spreadsheet does not need to contain those column headings, but they must 
be in that order. The tab does not need to be titled Contribution.

NOTE:	 If the data does not conform to the above specifications, the file will not import 
correctly. To ensure your file is formatted correctly, download the Excel template 
from the Upload Excel page.

You cannot use this functionality to contribute to accounts that have been closed. Contribution fields 
are unavailable for closed accounts, as in the example below.

To import contribution data from an Excel file, follow the steps below.

1.	 Click the Contributions menu and select Upload Excel. The Upload Excel page is displayed.
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2.	 Click Choose File to select an Excel file. 

3.	 Browse to the location where the Excel file is stored.

4.	 Select the file and click Open. The full path of the file is displayed in the Select a file to upload 
box.

5.	 Click Upload.
If the file uploads successfully, the contribution totals from the Excel file are displayed, as in the 
example below.

This page lists all employees from the imported Excel file, with fields for employee and/
or employer contribution amounts. You can click a column header to change the sort for that 
column.

NOTE:	 Multiple entries for a single employee are consolidated into a single entry.

6.	 If any of the data in the spreadsheet is invalid, an error message is displayed and errors are listed 
for each invalid row in the spreadsheet, as in the example below.
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Click the Download Errors link to download an error log file in Excel format. 
Fix the errors noted in the spreadsheet, remove the error messages and resave the file. For more 
information, see “Troubleshooting Errors” on page 28.
Click Clear and return to step 2 to reimport the file.

7.	 Search for employees by entering search criteria in the Search box and pressing <Enter>. You can 
search by first name, last name or Tax ID.

8.	 Specify the number of employees to list on each page of results by selecting the appropriate 
number from the dropdown menu to the right of the search box.

9.	 Select the check box for the effective year of the contributions, either the current year or the 
previous year. (If it is too late in the year to make contributions for the prior year, the prior year is 
unavailable.)

NOTE:	 Switching years automatically moves contributions to the year you select.

10.	If you need to add employees to the list, click the Add Employees link in the upper right corner 
of the page. The Add Employees page opens, listing your employees.
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Select the check boxes for the employees you want to add to the list, then click Add Employees. 
The Add Employees page closes and the employees are added to top of the contribution list.

11.	 Enter the appropriate Employee and Employer contribution for each employee for the selected 
year. The total amount is displayed at the top of screen.

12.	To view entries on previous or subsequent pages, click the page number links at the bottom of the 
page.

13.	When you have entered the contribution amounts, click Submit. The Contributions Review page 
is displayed.
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The page displays information on your contribution batch, including the number of employees 
with contributions and the total amount of contributions.
If you need to make any changes to the contributions, click Go back and go back to step 4.

14.	From the Funding Account list, select the account from which the contribution funds will be 
deducted.

NOTE:	 Contributions are memo posted to employee accounts immediately. Because of 
ACH processing times, it may take two to three business days for employers to 
see withdrawn funds.

15.	If necessary, modify the optional nickname for the batch in the Batch Nickname box. (The default 
nickname is a timestamp reflecting when the batch was created.) The nickname can help you 
identify the batch if you need to locate it later.

16.	Click Submit. The Contributions Receipt page displays the funding information, including the 
Debit Date, the Credit Date and the Available Date.
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•	 Debit Date 
Date that funds will be debited from the funding account that your company uses for 
employee HSA contribution.

•	 Credit Date
Date that funds will be credited into the employee’s HSA at UMB. The employee(s) will be 
able to see the contribution in the account but they will not be able to spend those funds until 
the funding ACH has cleared.

•	 Available Date 
Date that your employee(s) will be able to spend the dollars that were contributed to their 
HSAs. This date may be the same as Credit Date.

17.	 Print a copy of the page for your records.

18.	Click Close to return to the home page.

Reversing a Contribution
Follow the steps below to reverse a contribution.

1.	 Click the Contributions menu and select Reverse Contribution Form. A PDF of the Authorization 
to Reverse Employer Contribution form downloads.

2.	 Follow the instructions on the document to complete it.

3.	 Print, sign and submit the form.
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Changing a Batch Nickname
You can change a batch’s nickname, or assign a nickname to a batch that has had only default 
timestamp nickname assigned. You can work with batch nicknames on the Previous Batches page 
(accessible by clicking Contributions and selecting Previous Batch). 

You can also modify nicknames on the Batch History Report (accessible by clicking Reports and 
selecting Batch History).

To change a batch nickname, follow the steps below.

1.	 Click the batch’s Edit link. An Edit Batch box opens. 
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2.	 Enter a new name in the Nick Name box. (The default nickname is a timestamp reflecting when 
the batch was created.)

3.	 Click Update. A confirmation message displays. 

4.	 Click OK to close the message.
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Viewing Contribution History

Viewing Batch Details
To produce a report detailing a specific contribution batch, follow the steps below.

1.	 Click the Contributions menu and select Batch History. The Batch History Report page is 
displayed.

2.	 Enter a Start Date and End Date in the format MM/DD/YYYY.
-or-
Click the calendar icon  to select a date from a calendar.

3.	 Click Search.
The page refreshes, listing batch confirmation numbers, the day each batch was submitted, a 
nickname for each batch and details of each batch. 
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NOTE:	 If you sort the batch list on the Nickname column, batches with no assigned 
nicknames always sort to the bottom of the list.

4.	 Click a confirmation number to view the details of that batch. A Contribution Report opens, 
similar to the example below.

See “Viewing Reports” on page 27.

5.	 Search for batches by entering search criteria in the Search box and pressing <Enter>. You can 
search by batch name, batch ID or confirmation number.

6.	 Specify the number of batches to list on each page of results by selecting the appropriate number 
from the dropdown menu to the right of the search box.

7.	 Click OK to close the Contribution Report.

Viewing Employee Contributions
To produce a report detailing employee contribution history, follow the steps below.

NOTE:	 The report lists only those contributions made through the 
HSA Contributions Manager.

1.	 Click the Contributions menu and select Contribution History. The Contribution History Report 
page is displayed.
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2.	 Specify a range of dates for the contributions you want to view. Enter a Start Date and End Date 
in the format MM/DD/YYYY.
-or-
Click the calendar icon  to select a date from a calendar.
Entering a date range is required.

3.	 Enter a Confirmation Number if you want to view a specific batch.

4.	 Enter an Employee Name if you want to search for a specific employee account name.

5.	 Click Search. The report is displayed in a new window. See “Viewing Reports” on page 27.

Viewing Reports
Batch detail reports and employee contribution history reports feature buttons and icons that enable 
you to perform various tasks within the window.

•	 Click  to export the report to an Excel file.

•	 Click  to export the report to a PDF file.

•	 Click  First Page to jump to the first page in the report.

•	 Click  Previous Page to jump to the previous page in the report.

•	 Click  Next Page to jump to the next page in the report.

•	 Click  Last Page to jump to the last page in the report.
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Troubleshooting Errors

The table below lists error messages you may encounter in the HSA Contributions Manager, as well 
as steps you can take to correct the issues. With the List of Employees and Previous Batch tasks, 
error messages are displayed within the interface. With the Upload Excel task, the errors are listed in 
the log file.

Error message Task Action to take
Account not found Import UMB does not have an HSA for this person. Correct the Social 

Security Number or remove the employee from the spreadsheet 
and upload the file again.

Closed Account Previous 
Batch

You cannot enter contributions for employees with closed accounts

Import Remove the employee from the spreadsheet and upload the file 
again. 

Contains invalid 
employee contribution 
amount

Import Correct the format of the amount on the spreadsheet and upload 
the file again.

Contains invalid 
employer contribution 
amount

Import Correct the format of the amount on the spreadsheet and upload 
the file again.

Contains invalid SSN Import Correct the format of the Social Security Number on the 
spreadsheet and upload the file again.

Invalid entry List Correct the format of the employee or employer contribution 
amount that was entered.

Previous 
Batch

Correct the format of the employee or employer contribution 
amount that was entered.

Year to date 
contributions exceed 
limit

List The total of previous contributions and the contributions that you 
are currently processing exceeds the limit set by the IRS for the 
year. Lower the contribution amount (or change it to zero).

Previous 
Batch

The total of previous contributions and the contributions that you 
are currently processing exceeds the limit set by the IRS for the 
year. Lower the contribution amount (or change it to zero).

Import The total of previous contributions and the contributions that you 
are currently processing exceeds the limit set by the IRS for the 
year. Lower the contribution amount (or change it to zero), and 
upload the file again.
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Viewing Employer Reports

HSAWorks offers Health Savings Account employer reports. The interface enables you to view the 
reports, drill down into the data, and export them to multiple formats.

Accessing Employer Reports
To access HSAWorks, follow the steps below.

Click the Reports menu and select HSAWorks to proceed to the HSAWorks homepage (illustrated 
below), which opens in a new window.

The HSAWorks homepage displays a number of data points and graphs, including:

•	 Counts: Open Accounts, Investment Accounts

•	 Balances: Total Balance, Deposit Balance, Investment Balance

•	 YTD Contributions to Last Year

•	 Portfolio Balances

•	 Total Balance 5-Year Trend

•	 Current Year Contribution 5-Year Trend

•	 Account Status 5-Year Trend

•	 Percentage of Accounts with Contributions Last 13 Months
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On the left side of the page, you will see links to four more pages of graphs. These pages, along with 
the data they present, are listed below.

•	 Balances

•	 Balance Data: Total Balance, Deposit Balance, Investment Balance, YTD Balance Change, 
YOY (year-over-year) Balance Change, Average Account Balance

•	 HSA Deposit Analysis

•	 Portfolio Balances

•	 Total Balance to Contribution Ratio

•	 Deposit Balance by Rnge 5-year Trend

•	 Total Balance 5-Year Trend

•	 Contributions
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•	 Contribution Data: YTD Contributions, YTD Employee Contributions, YOY Total 
Contributions, Accounts with Contributions, Accounts with Employee Contributions

•	 YTD Contributions to Last Year

•	 Current Year Contributions 5-Year Trend

•	 Percentage of Accounts with Contributions Last 13 Months

•	 Prior Year Contributions 5-Year Trend

•	 Distributions

•	 Distribution Data: YTD Distribution Amount, YTD Distribution Count, YOY Distribution 
Amount, YOY Distribution Count, Average Distribution Amount, Account with Distributions

•	 Distribution Amount by Source 5-Year Trend

•	 Distribution Count by Source 5-Year Trend

•	 Average Distribtuion Amount by Source 5-Year Trend

•	 Accounts with Distributions Trend Last 13 Months
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•	 Accounts

•	 Counts: Open Accounts, Investement Accounts, New Accounts YTD, Closed Accounts YTD

•	 Open Accounts 5-Year Trend

•	 Investment Accounts 5-Year Trend

•	 Account Status 5-Year Trend

Filtering HSAWorks Graph Data

You can filter the data used to create the graphs on the HSAWorks page. The view defaults to the 
most recent reporting period (Current Date). 

•	 To display graphs for another reporting period, select a date from the As of Date list. The graphs 
refresh to reflect data as of that chosen date.

•	 Click Reset to revert the graphs to their default view.

Working with HSAWorks Graphs
When you mouseover the graphs on the five pages within HSAWorks, a number of controls display 
that enable you to work with the data represented in these graphs.

Click to drill back up to a higher level of data.
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Clicking this icon enables you to drill down into the data by clicking elements of the graph. Click 
again to turn off that functionality.
Click to drill down into the next level in the data.

Click to expand all data down one level in the hierarchy.

Click to enter Focus Mode, which expands the graph to full-screen. (Click Back to report to 
return to the normal view of the HSAWorks homepage.)
Click to open a menu with more options.

•	 Export data opens a window that enables you to export the data in the graph 
to an Excel file or a CSV (comma-separated values) text file. (See “Exporting 
Graph Data” below.)

•	 Show as a table opens the graph in full screen and displays the underlying data 
in a table underneath the graph.

•	 Spotlight dims the rest of the screen to highlight the graph. Click Spotlight 
again to return to the normal view.

•	 Sort descending (high to low) and Sort ascending (low to high) sorts the data 
appropriately.

•	 Sort by enables you to sort the data in the graph by time or by the columns 
represented in the data. The columns will vary depending on the graph.

Exporting Graph Data
To export the data from a graph displayed on the HSAWorks page, follow the steps below.

1.	 Mouseover the appropriate graph on the page.

2.	 Click More options  and select Export data. The Export Data window opens.
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3.	 Select the data you want to export: Summarized data or Underlying data. Underlying data may 
not be available, depending on your permissions.

4.	 Specify the File format.

•	 Excel (.xlsx) files can export no more than 150,000 rows.

•	 Comma-separated values (.csv) files can export no more than 30,000 row.

5.	 Click Export. A progress box displays during the export process.
When the exported file is complete, it is downloaded to your PC according to the download 
settings you have configured in your browser.

Reports Overview
•	 Account Detail List

A list of your employees with HSA accounts as of the selected date. A sample is pictured below. 
This is a tabular report which includes the following columns of data on the employees:

•	 Social Security Number

•	 Last Name

•	 First Name

•	 Middle Name

•	 Address

•	 Address 2

•	 City

•	 State

•	 ZIP Code

•	 ZIP Code 4

•	 Account Status
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•	 Account Open Date

•	 Email

•	 Last 4 of Debit Card

•	 Account Summary Report
A report summary of account balances, contribution, and distribution information for the 
selected Partner and Employer. Sample pages are pictured below.
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•	 Account Summary - Detail Data
A detailed summary of account balances, contribution, and distribution information for the 
selected Partner and Employer. This is a tabular report which includes the following columns of 
data:

•	 TPA Name

•	 Employer Name

•	 Total Accounts

•	 Open Accounts

•	 Investment Accounts

•	 Accounts Opened YTD (year-to-date)

•	 Accounts Opened MTD (month-to-date)

•	 Accounts Closed YTD

•	 Accounts Closed MTD

•	 Total Balance

•	 Deposit Balance

•	 Investment Balance

•	 Non-Investor Accounts
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•	 Investor Deposit Balance

•	 Non-Investor Deposit Balance

•	 Employee Contribution YTD Qty

•	 Employee Contribution YTD Amt

•	 Employer Contribution YTD Qty

•	 Employer Contribution YTD Amt

•	 Employee Contribution MTD Amt

•	 Employer Contribution MTD Amt

•	 Distribution YTD Qty

•	 Distribution YTD Amt

•	 Card Activity YTD Qty

•	 Card Activity YTD Amt

•	 Check Activity YTD Qty

•	 Check Activity YTD Amt

•	 Other Activity YTD Qty

•	 Other Activity YTD Amt

•	 Distributions MTD Qty

•	 Distributions MTD Amt

•	 Card Activity MTD Qty

•	 Card Activity MTD Amt

•	 Check Activity MTD Qty

•	 Check Activity MTD Amt

•	 Other Activity MTD Qty

•	 Other Activity MTD Amt

•	 Accts Employee Contr MTD Qty

•	 Accts Employer Contr MTD Qty

•	 Accts Employee Contr YTD Qty

•	 PY Employee Contr MTD Amt

•	 PY Employer Contr MTD Amt

•	 Accts PY Employee Contr MTD Qty

•	 Accts PY Employer Contr MTD Qty

•	 PY Employee Contr YTD Amt

•	 PY Employer Contr YTD Amt
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•	 Accts Distribution MTD Qty

•	 Account Summary Trends
A package of comprehensive graphs illustrating a rolling 16-month snapshot of your group’s HSA 
trends. These graphs include balances, contributions, distributions, investments, and long-term 
savings information so you can understand your specific trends and also compare your group’s 
HSA usage with that of the overall average for the entire UMB Bank book of HSA business. This 
will provide insight into how your organization’s participants use their Health Savings Accounts 
and provide an idea of how you stack up against our portfolio averages.
Throughout this report set, the orange trend line represents UMB Bank’s total portfolio. In 
comparison, your specific group is represented by the yellow trend line.
Each graph also has one or two key “takeaways” or important concepts that we have explained in 
a narrative for each of the graphs.

•	 Current Year Contribution Totals

The left axis of this graph displays total contributions by month, for both employer and 
employee, and the right axis shows the per account total contribution average by month for 
the group and the UMB benchmark. The key takeaway with this graph is how the group’s 
average contribution per account (represented by the yellow line) compares to the all-bank 
benchmark (indicated by the orange line).
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•	 Current Year Contribution Averages

This graph displays a further breakdown of the average contributions by month for both 
employer and employee amounts on the left axis, while the right axis shows the percentage of 
accounts with an EE contribution. 
The key aspect here, again represented by the orange and yellow lines, is “How does the 
group’s percentage of accounts with employee contributions compare to the benchmark?” 
This is a vital metric since it is a good barometer for employees’ engagement in their HSAs.

•	 Prior Year Contribution Totals

From January 1 through April 15 of each year, account holders can make contributions to an 
HSA for the prior year. This graph displays the average and total prior year contributions per 
account versus the average and total prior year contributions for all of UMB. Account holders 
making such contributions are typically making the most of their HSAs, taking advantage of 
the tax benefits of those contributions. 
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•	 Contribution to Distribution Ratio

This graph shows a simple ratio by month of average contribution vs. distribution for the 
same month. In other words, if the accounts had more money put in vs. taken out for the 
month, the number will be positive. If there was more money taken out than put into the 
account for the month, the number will be negative. We provide this view month-by-month 
for both the employer group in dark blue and the bank average in light blue.
Employers should not focus on this metric on a month-by-month basis because there are too 
many factors that can impact this measurement in any one month. Additionally, since this is 
impacted by the timing of account funding and the resetting of plan year deductibles, there 
may be seasonal impacts on any given months. 
However, the real takeaways here are: 
(1) You want to have more months in the positive than the negative, and 
(2) what is the group’s overall trend?  
This gives the employer some very detailed views on how the given plan dynamics are 
impacting their overall trend for the entire year.

•	 Deposit Account Balances
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This graph shows the total (left axis) and average (right axis) account balance by month, and 
the key takeaway again is “How does the group’s average balance compare to the all-bank 
average, again shown by the orange and yellow lines?” This can also be vitally important 
to see what the overall balance trend is, but the next slide will dissect the balances in even 
greater detail.

•	 Deposit Account Balance Ranges

This graph provides a breakdown of all accounts by balance tier, bracketed into 10 different 
ranges, and how they change over time. This is a really important view into the spectrum of 
accounts, and one that would never be seen by just looking at the average balance.
This allows you a deeper look at the distribution of balance ranges, which is far more telling 
than just the average balance. For instance, depending on the actual group funding dynamics, 
you could actually have a situation that the average account balance is going up, while the 
average employee’s account is not.
This could be caused by an employer that has a number of strong funders making max 
contributions that are pulling up the average, but simultaneously the average account has 
next to nothing. This disparity, or “bookending,” could easily be identified by looking at the 
balance tier distribution. 
This graph also helps you keep tabs on the zero- or low-balance accounts.
So the key takeaways here are: 
(1) Does the group have a healthy distribution of balance ranges, and 
(2) How is the group managing the low balance accounts?
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•	 Investment Accounts

Reflects the group’s number of employees choosing to invest HSA balances in mutual funds 
and compares the percentage of accounts choosing investments to the percentage for all UMB 
Bank HSA Accounts. Employees that choose to invest are more likely to be engaged in their 
HSA over the long-term..

•	 Investment Balances

Reflects the total amount of a group’s funds that are invested in mutual funds and compares 
the average investment balance per investment account to the average for all UMB Bank 
HSA investment accounts.
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•	 Distribution Transactions by Type

This slide reflects the breakdown of distribution transactions by type, with the total (left axis) 
and average number (right axis) of distributions by month, along with method of distribution. 
The key takeaway here, again, is “How does the group’s distribution frequency compare to 
the average?” Large discrepancies may point to issues that require further investigation.

•	 Distribution Totals by Type

This graph displays the total (left) and average (right) distribution by month, along with 
volume of distributed dollars, broken down by the method of distribution.
There are actually two key takeaways on this graph: 
(1) the average distribution per account in yellow vs. all bank average benchmark orange line, 
and 
(2) the method of distribution – how the employees are taking their distributions, which is 
shown by the various colors on the chart bars, showing debit card, online/ACH, and checks.
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•	 Distribution Averages
This graph reflects the group’s average amount spent per transaction compared to the 
benchmark average. This is a good barometer of spending.

•	 Remaining Balance to Contributions

This graph provides a long-term look into account dynamics. It allows the employer to break 
down the type of account utilization for their group, and see exactly how that distribution can 
change over time. 
This graph shows a ratio of the current account balance versus the total of all contributions 
ever made into the account. For sake of ease here, it is bracketed into eight different tiers. 
These tiers help identify the breakdown of the spending and saving within the group’s 
accounts.
This make up of spenders versus savers is incredibly telling for the spectrum of account 
holder activity within the group. More importantly, as an employer trying to drive positive 
behavior change to the group, you can monitor this metric and how it changes over time.
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•	 All UMB Remaining Balance to Contributions
This graph reflects the ratio of current total balance (deposits and investments) to the total of 
all contributions ever made for all UMB Bank HSA accounts, to be used as a benchmark for 
the group’s ratio breakdown in the previous chart.

•	 Employer Contribution Report
This report enables the employer to run a list of every single contribution made into each account 
for the selected time period. This can be helpful for auditing or compliance purposes. This is a 
tabular report which includes the following columns of data:

•	 Employer Name

•	 TPA ID

•	 Employer ID

•	 Date Posted

•	 Last Name	

•	 First Name	

•	 Middle Initial

•	 Suffix

•	 SSN

•	 Amount

•	 Description

•	 Source

•	 Enrollment/Maintenance Response Report
This is a tabular report which includes the following columns of data:

•	 Effective Date	

•	 TPA ID	
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•	 Employer ID	

•	 SSN

•	 Last Name	

•	 First Name

•	 Middle Initial

•	 Response Data Code

•	 Response Data Message

•	 Transaction Type

•	 Physical Address 1

•	 Physical Address 2

•	 Physical City

•	 Physical State

•	 Physical Zip Code

•	 Mailing Address 1

•	 Mailing Address 2

•	 Mailing City

•	 Mailing State

•	 Mailing Zip Code

•	 Work E-mail Address

•	 Home Email Address

•	 Work Phone

•	 Home Phone

•	 Date of Birth

•	 Employee ID

•	 HDHP Effective Date

•	 Account Open Date

Viewing Reports
To open and view a report, follow the steps below.

1.	 From the As of Date list, select the date of the data to be displayed in the report.

2.	 Click the name of a report on the Reports list. The report opens in a new tab.
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Using the Reports Toolbar
When reports are displayed, a special toolbar at the of the window enables you to perform various 
tasks with the report. 

•	 The File menu offers printing options. See “Printing Reports” below.

•	 The View menu enables you to change how the report is displayed on the screen. See “Changing 
Report Views” on page 48.

•	 The Export menu enables you to export thre report into a number of useful formats. See 
“Exporting Reports” on page 49.

•	 Use the arrow buttons to navigate through multi-page reports. The page you are currently 
viewing and the total page count are displayed.

•	 Enter a page number and press <Enter> to go directly to that page.

•	 Click  to go to the first page of the report.

•	 Click  to go to the previous page of the report.

•	 Click  to go to the next page of the report.

•	 Click  to go to the last page of the report.

•	 The Parameters icon opens a toolbar that enables you to filter the data displayed in the report. 
See “Modifying Report Parameters” on page 49.

•	 The Page Settings icon enables you to configure report page appearance. See “Changing Report 
Views” on page 48.

•	 The Print now icon enables you to quickly print a PDF of the report. See “Printing Reports” 
below.

Printing Reports
Printing a report from the File menu creates a printable PDF version of the report that is displayed on 
the screen. To do so, follow the steps below.

1.	 From the File menu, select Print. A Print window opens.
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2.	 If necessary, modify any default print settings: Page Size, Height, Width, Units, and Page 
Orientation.

3.	 Click Preview to go to the Page View version of the report.

4.	 Click Print. The PDF is created and the standard system Print dialog opens.

5.	 Click Print to send the report to the printer.

Clicking Print Now enables you to quickly print the report PDF with default settings. To do so, follow 
the steps below.

1.	 Click Print now. The PDF is created and the standard system Print dialog opens.

2.	 Click Print to send the report to the printer.

Changing Report Views
The View menu gives you control over how the report is displayed in your browser window. The 
interface givces you two options: Default and Page View.

•	 Selecting Default from the View menu displays the report contents in the browser, similar to a 
web page.

•	 Selecting Page View from the View menu displays the report as it would look when printed.

•	 When you display a report in Page View, the Page Settings icon is available in the toolbar. 
Clicking this icon opens the Page Settings window.
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Modify any default print settings: Page Size, Height, Width, Units, and Page Orientation.
Click OK.

Exporting Reports
You can export the contents of the report to multiple formats:

•	 Microsoft Excel (.xlsx)

•	 PDF (.pdf)

•	 Accessible PDF (.pdf)

•	 Comma Separated Values (.csv)

•	 Microsoft PowerPoint (.pptx)

•	 Microsoft Word (.docx)

•	 Web Archive (.mhtml)

•	 XML (.xml)

To export the report, follow the steps below.

1.	 Click the View menu.

2.	 Select the format for export. A progress box displays during the export process.
When the exported file is complete, it is downloaded to your PC according to the download 
settings you have configured in your browser.

Modifying Report Parameters
Some reports allow you to filter the data displayed in the report. Those reports display the 
Parameters icon in the toolbar. Clicking that icon opens the Parameters toolbar, an example of which 
is pictured below.

The data columns you can filter will vary depending on the report displayed. The reports you can 
filter and the columns available for filtering are listed below.
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•	 Account Detail List

•	 Last Name

•	 First Name

•	 Last 4 SSN (Last four digits of Social Security Number)

•	 Account Status (Active, New, Inactive, Dormant, Escheatable, Pending Closure)

•	 Employer Contributions Report

•	 From Date

•	 To Date

•	 Last Name

•	 First Name

•	 Enrollment/Maintenance Response Report

•	 From Date

•	 To Date

•	 Last Name

•	 First Name

•	 Error (Was an error triggered? Yes, No)

To filter report data, follow the steps below.

1.	 On the reports tolbar, click Parameters. The Parameters toolbar displays.

2.	 To filter on a specific value in a field, uncheck the Null checkbox and enter a value to filter 
against.
-or-
Select Null to disable the filter for that field, which will allow any value in the column, including 
no value at all.

3.	 For date-related columns (From Date, To Date), enter a date in the format MM/DD/YYYY.
-or-

Click the Date icon  to select a date from a calendar.

4.	 For columns that enable you to select specific values (Account Status, Error), select one or more 
items from the list. You can also choose Select All to choose all items in the list.

5.	 Click View Report to update the report based on the parameters you specified.


	Introduction
	Disclaimer
	What’s New in Version 6.11
	Updated Login Interface

	Accessing the HSA Contributions Manager
	Browser Requirements
	Setting Up Your Web Exchange Security Profile
	Viewing Demo Videos

	Entering and Funding Contributions
	Manually Entering Contribution Amounts
	Populating from a Previous Batch
	Importing Contributions from an Excel File
	Reversing a Contribution
	Changing a Batch Nickname

	Viewing Contribution History
	Viewing Batch Details
	Viewing Employee Contributions
	Viewing Reports

	Troubleshooting Errors
	Viewing Employer Reports
	Accessing Employer Reports
	Filtering HSAWorks Graph Data
	Working with HSAWorks Graphs
	Exporting Graph Data

	Reports Overview
	Viewing Reports
	Using the Reports Toolbar
	Printing Reports
	Changing Report Views
	Exporting Reports
	Modifying Report Parameters




